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Initial Set Up

To use the Trainers Scheduler, we need to make sure we have a few things set up.

e Trainers added to the “Trainers & Assessors” area.
e Configure the “Scheduler” area.
e Course in the system

e Create training sessions for course

3|Page



3
Trainers

How to add a Trainer to PowerPro Assessors

From the Home menu click on the Trainers and Assessors icon.

In the Trainers & Assessors window, click on NEW to add a trainer into the system. As in all
areas of PowerPro any field in red is mandatory, so to be able to save information is required
in this field. Best policy is to add as much information as possible. Select a colour for the
trainer, this will indicate the trainer on the scheduler.

Trainers and Assessars

List View \
Mew Edit

Show Inactive Trainers/Assessors

Trainers/Assessors

Trainer fAssessor Mame Active . . . .
Main Info | Academic Info | Courses Completed | Documents | Contactlog | Vocational Competencies | My Trainer fields

\ Sumname

G Mames

Calendar Colour Colour not selected » *+ Active =
Address

Suburb

Postcode State/ Teritony -

Phane () - Mobile

R : |

E-mail
Company Name
Identifier

Web Password

Motes

Once you have added information on the main page, please save so they appear on the “List
View” on the left side of page before adding any other information to the following tabs of

the trainers.

To use the Trainers Scheduler, we only need the basics as pictured.

Trainers and Assessors

List View
Show Inactive Trainers/Assessors New Edit

Trainer (Assessor Name Active

MILTON, MILLY “

Main Info | Academic Info | Courses Completed | Documents | Contactlog | Vocational Competendes | My Trainer fields

Surnarme MILTCM
G.Mames MILLY
Calendar Calour N DeepSkyBlue + == Active v
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Configuring the Scheduler

From the Configurations menu click on “Application Options” icon.

The Application option window will appear, this is where you configure all the areas of

PowerPro. Please go to the “Scheduler” Tab.

als Configuration Help
% [ » Y = - Enable AVETMISS
} Q. @ i/ u} =] \k by .]" P D navie i
<=9 \ - == = — Enable RAPT
resh User Roles  Manage Training Units of Application | Price  Email International VET Units  Module Colour
ssions 8 Actions  Users Organisation Competency Options List  Alerts - of Study  Mapping Scheme E:E:I Default values
RTO | Clients | Ervolments | AQF | Cort. Improvement | Doctypes | Templates | Trainer | Contactlog | Companies | Inwoicing | Scheduler | Course | Enguiies | SMS
Trainer/Course Scheduler options
Scheduler Cell Colours Default Colour/Label for new Events
Label Colour B 2oply Make up -
Heavy Vehide | dBlack
Eirst Aid ] dRed Colour for Public Holidays
Apply Make up B cFuchsia I cRed h
Forkift 255,255,12 ) o0 =
PowerPro RTO B 0.125.255 el : -
EERUIDESET L2, Session default Finish Time 16:00 pt
Induction dsilver

H#H 4 r B+ — - Xk T

Allow multiple day Sessions
Default Scheduler view to "Active courses™ only
Clone Sessions when cloning a Course

Event Captions

Course National Code (eg TAA40104)
Course Number (e.g. 175)
Course Version (e.g. Jane 2009)

(@) Course Name (e.g. C4 - Workplace Trainer)
Delivery Location
None - Caption entered manually

Event Hints {mouse over)
*) Same as Event caption
@) Seats leftin the course

0K

*

Bookmarks

wieh

Cancel

First, we need to add your program names under the “Scheduler Cell Colours” on the left. If

you have some there already there you can modify these by clicking on the line and rename

this label, you can select a new colour or keep the existing. To add new courses, click on the +

symbol at the bottom of this box a new line will appear. Enter the new course name then

select colour.
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On the right side of the scheduler window, set the following.

e Default Colour/Label for new Events
Select which course you would like to make your default course (the course you
deliver the most).
e Colour for Public Holidays
Select your preference for colour marking public holidays on scheduler.
e Session Default Start and End time
Set a set start and end time for your training sessions.
e Allow multiple day sessions — tick box to select.
e Default Scheduler view to “Active course” only — tick box to select.
e Clone sessions when cloning a Course — tick box to select.
If the course you are cloning already has session created, it will clone these sessions
and adjust them to fit within course start and end dates.
e Event Captions
Select an option from the list as to how you see session on Scheduler.
e Event Hints (mouse over)
Select option from list of view to see when hover over session.

Now create your Accredited/Non-Accredited course in PowerPro and add the trainer/s.
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Create Session/s for Course

Select the course that you wish to add sessions too. This can be done from the ACC/NATM or
Enrolment & Results window.

To access the course set up areas, double click on the course to edit details.

Select “Scheduled Sessions” tab.

Qualification Level Program name Group/Version Start Date End Date Locatior
|_Jcowse _________|Aooly MakeUp | 28May2is

Main Info | wWorkflow | Scheduled Sessions | Attendance | Trainers/Resources | Docs | Invoicing | Company Invoices | Units | AVETMISS | HR | web

Course - Scheduled Sessions
Mew Session Edit Session Change Location | - Change Trainer | - Clone Session Delete Session

Date Week Day Start End Location Trainer Units

Click on “New Session” another widow will appear, this is to create the first session. Start
from the top select (1) trainer from the drop down. If they are not there, then you have not
added them into the system as yet. Go back to page 4 to see how to add trainer. The course
field is greyed out as you are not able to create session for another course (2) Units-
possibility to select units associated with this session (max 6 units allowed) You don’t need to
select any units, as you may not know what units the trainer will be delivering on that session.
(3) Location- this will prompt as the location set up on the course. You can select another
location from the drop down or create a new location by clicking on the “New Location”
button. (4) The Caption default to the Scheduler settings or you can change on the “Set
Caption as” to the selection available. (5) The Colour/Course type is next and will default to
again the scheduler setting or use the drop down to select another course. (6) Course Dates
fields are greyed out as they are picked up from the course start and end date. Cont...
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(7) Trainer Cost - is there if you would like to associate a cost for the session. (8) Session Date-
is automatically pick up from the start day of the course, you can select another date that is
within the start and end date of course. (9) Start and End Time fields are picked up from the
scheduler defaults. But maybe changed here. (10) There are 2 tabs at the bottom “Notes” and
Session Plans”. The Notes can be added on the class roll by using the merge field in the Roll
Templates.

Once you are happy with the details, click ok and this session will now appear as a scheduled
session.

Main Info | “workflow | Scheduled Sessions | Attendance | Trainers/Resources | Docs | Invoicing | Company Invoices | Units | AVETMISS | HR | 'Wweb

Course - Scheduled Sessions
Mew Session Edit Session Change Location |+ Change Trainer |+ Clone Session Delete Session

Date Week Day Start End Location Trainer Units

28 May 2018 Seaside Beauty _MILLY MILTON |

To clone this session, highlight the session then click on “clone session”.

As an example, | have a course that runs from the 28™ May to 8th of June 2018, as you can
see | have my first sessions.

| am going to create 4 more sessions spaced by a day to give us the week.

7
Options
Mumber of Clones 4 :
Space by 1 o | dayls]
Start ime 09:00:00 %
End time 15:00:00 5
ak Cancel
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Main Infa | Wworkflow | Scheduled Sessions | Attendance | Trainers/Resources | Docs | Invoicing | Company Invoices | Units | &YETMISS | HR | ‘Wweh

Course - 5cheduled Sessions
Mew Session Edit Session Change Location |+ Change Trainer | - Clone Session Delete Session

Date Week Day Start End Location Trainer Units
28 May 2018 SeasdeBeauty lMiywmron [ |
29 May 2013 Tuesday 05:00 16:00 Seaside Beauty — MILLY MILTON
30May 2018 Wednesday  05:00 16:00 Seaside Beauty — MILLY MILTOM
31May 2018 Thursday 03:00 16:00 Seaside Beauty — MILLY MILTOM
01 Jun 2013 Friday 05:00 16:00 Seaside Beauty — MILLY MILTON

Now | need to create another 5 sessions, so we have 10 sessions to take us up to 8% June.

Highlight the first day and click on clone, this time we want to clone just 1 session spaced by 7
days this will give us our 2" Monday. Now repeat this by highlighting the Tuesday and click on
clone, again clone by 1 and spaced by 7 days. Do this for the other 3 days.

This is how it should appear.

Course - Scheduled Sessions
MNew Session Edit Session Change Location | = Change Trainer | = Clone Session Delete Session

Date Week Day Start End Location Trainer Units
28 May 2018 Monday 09:00 16:00 Seaside Beauty — MILLY MILTOMN
29 May 2018 Tuesday 09:00 16:00 Seaside Beauty — MILLY MILTON
30 May 2018 Wednesday 09:00 16:00 Seaside Beauty — MILLY MILTOMN
31May 2018 Thursday 09:00 16:00 Seaside Beauty  MILLY MILTON
01 Jun 2018 Friday 09:00 16:00 Seaside Beauty — MILLY MILTOMN
04 Jun 2018 Monday 09:00 16:00 Seaside Beauty  MILLY MILTON
05 Jun 2018 Tuesday 09:00 16:00 Seaside Beauty  MILLY MILTON
05 Jun 2018 Wednesday 09:00 156:00 Seaside Beauty  MILLY MILTOM
07 Jun 2013 Thursday 09:00 16:00 Seaside Beauty — MILLY MILTON
08 Jun 2018 Friday 09:00 16:00 Seaside Beauty — MILLY MILTOMN

By double clicking on the session it will re-open window and you can modify anything you
need too. Or highlight the session and then right click, here you can select from a menu
option for editing the details of that session.

Now that you have created the sessions we can now go to the trainer scheduler and see our
sessions there.
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Viewing sessions for Trainers

Manday Tussday Wednesiay Thuaday Frcay Saturday/Suray

03100 16:00 Course - Apgiy Meke U 0300 16:00 Cowse - Ay Make U 000 16:00 Cowse - Ay Make U D00 16:00 Coures - Anchy Mske U 0300 16:00 Course - Ay Make U

3| | G
03:00  16:00 Course - Apgiy Make L D300 16:00 Cowrse - Ay Make U OB00 16:00 Cowse - Apply Make U D00 15:00 Coures - Aaghy Maske U 0300 16100 Cowrse - Ay Make U

When you open the Trainers Scheduler, spend some time exploring as there are many options
for viewing here. As you will see we have filters on the top of this area as well. You can filter
on active or archived or both, use a filter on courses. i.e Title match, Course ID, version match,
State

Trainer Scheduler
Course Filters Print/Export

Active Courses  « | Title match Course ID Version match 7 Refresh P (3] WA - m Manage PH

Refresh- When you add or remove any search on the filters click on the refresh.
Print/Export Area- Here you have 3 icons a Print, Preview and Export.

Print Icon — allows you to print to your selected printer.

Preview Icon- allow you to open to preview and make some formatting changes.

Mail Icon- Allows you to sync calendar to outlook.

Manage Public Holidays- once you have entered the public holidays in for a state/s, the follow
year can then be copied/cloned.
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Trainer Scheduler Preview Filter

4 May 2018 3
M TWTFS5 5
=30 1 2 3 4 5 &
| 7 8 910 11 12 13
x0[14 15 16 17 18 19 20
21|21 22 23 24 25 25 27

z|2g20]3031 1 2 =
= 5 6 7 8 210

< ==
View | Options | Day
Scale Mode
() Day i
@) Week L Al
(_) Month
i) Time Grid | (@) Traim
) Year '

Trainers (Active only)
<Al States/Territorie =
/] MILLY MILTON

On the right side of the Trainers Scheduler we have a view to select
calendar. The left and right arrows at the top of the calendar, go from one
month to the next. The left and right arrows at the bottom of the calendar
move you from one week to the next. As you change this, it will reflect on
the main area of the scheduler.

Next, we have the View, Options and Day tabs.

The View Tab- allows you to select the Scale & Mode in which to view the
calendar. The Scale criteria is to view either by i.e. Day, Week, Month,
Time Grid or Year. The Mode allows you to select the view, being ‘All’
scheduled training sessions or you can select by ‘Trainer’. The Trainer
selection allows you to view the period and all selected trainers. See
display
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Trainer Scheduler — Multiple Trainer View

Course Filters int/Export

e L A0 ML R l— )

Monday Tuesday Wednesday Thursday Saturday,/Sunday

("] PEDRO FONSECA
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4 May 2018 [
M TW TF 5 5
530 1 2 3 45 6 i
= 7 B 91011 12 13 to view per page, as well as show or not show weekends
2|14 1516 17 18 19 20
21|21 22 23 24 25 25 27
=|28293031 1 2 3
=l 4[5 6 7 8 210

The Options Tab - Allows you to select how many trainer you would like

<< =z

View | Options | Day

View Options

Trainers pf page |5

Show Weekends w

Trainers (Active anly)
<Al StatesTerritorie =

/| JACK DUNDEE
/] NIELS VAN TOOR
PEDRO FONSECA

4 June 2018 » . The Day Tab — Allows you to set the time scale in either 15, 30 or 60-
M TWTF S 5

=(28293031 1 2 3
=l 4 5[6] 7 8 910  as well as setting a work time only view.
#1112 13 14 15 16 17
=18 19 20 21 22 23 24
(252627 2829 30 1
72345678

minute intervals when viewing the scheduler on the day scale option,

= i

View | Options | Day

View Oplions

Time Scale |15 Mine -

Waork Time Only ¥
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Syncing PowerPro Calendar to Outlook

If you only have one calendar it will automatically sync, it is when you have more than one that
it becomes more complex. PowerPro will only sync to a calendar that is linked to an email
address. If you have more than one calendar, you will need to make sure that you set Outlook
to default this calendar.

To do this go to Outlook, click on the File Menu at the top of the window. Next go to Account
Settings, click on the drop-down arrow and select the first option
“Account Settings”.

©

Account Information

Open & Export
E X0m.au .
Save As POP/SMTP
+ Add Account -
Save Attachments
: Account Settings
Print ..
el Change settings for this account or set up more connections.
Account Get the Outlook app for iPhone, iPad, Android. or Windows 10 Mobile.
Seﬂings' *‘—-__
Office ——
Account
= Mailbox Settings
Feedback j— Manage the size of your mailbox by emptying Deleted Items and archiving.
Tools
Support
Options a Rules and Alerts
=1 Use Rules and Alerts to help organize your incoming email messages, and receive
Exit Manage Rules updates when items are added, changed, or remaoved.
& Alerts
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Once you click on Account Settings, you will then see a box appear as below.

Select the 2" Tab “Data Files”, it is here that you need to select the email address associated
with the calendar and set it to be the default account for any data files. By highlighting the
account name and then selecting the option above here to “Set as Default”. As you can see
below the first account is selected as the default.

Account Settings .
Data Files
Cutlook Data Files
Email  DataFiles RSS Feeds SharePoint Lists Internet Calendars Published Calendars Address Books
g Add.. 5 Settings.. (@ Setas Default X Remove ) Open File Location..,
Mame Location
@accnu . pst
accou
alisor 15t
alisor
alisor
marke .au.pst
serge
suppt I I it I I 1.pst
You can set up rules so that you Calendar from PP sync to Outlook in the colours that you
would like. This is done using “Conditional Formatting” in Outlook.
To do this in the Calendar in Outlook, go to the “View” Menu, here then select the “View
Settings” area.
File Home Send / Receive Folder View Help Q Tell me what you want to do
ﬂ' 2, Tirme Scale - = p—

C g v EEEHE E e 1] [BE [E
Change View @ Reset Day Work Week Month Schedule Colar Folder Reading To-Do
View = | Settings  View Week View @ Pane~ Pane~ Bar~

Current View Arrangement a| Color Layout
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From the View Settings” you will then see “Advanced View Settings: Calendar window”. Select
“Conditional Formatting”.

Advanced View Settings: Calendar s

Description

Columns... Start, End

Group By...

Sort...
| Filter.. | off
| Other Settings... | Fonts and other Day/Week/Month View settings
| Conditional Formatting... | User defined colors for appointments
Format Columns...

| Reset Current View | | oK | | Cancel |

Here you can see we have created two Rules, one for Health and the other for Animal. When
we sync from PowerPro

any session that has the word “Health” in the Subject will be colour coded orange and anything
with Animals is Olive Green.

_ - S X !
Rules for this view:
@Animal
23 24
_ |:. Moveup

Properties of selected rule

Mame: |Health
30 31| Color | || ni
it AT OGO Co "

oK | | Cancel ||
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You can use any text that comes into Outlook from PowerPro Calendar, as above i.e. Trainer
Name, Program Name, Location. To do this you need to create a condition. After you have
created the rule click on the button “Condition”

You will see the below screen. Type in the Key search word and in the search “in” keep this as
the “subject field only”.

Appointments and Meetings  maore Choices  Advanced

Search for the word(s): |Health o

In: | subject field only w

Crganized By...

Attendees...

Time: |none w || | Anytime

OK Cancel Clear All

I r

You should now be ready to sync from PowerPro to Outlook.

Go to Trainers Scheduler and click on the email icon as highlighted below, which found under
the Print/Export area. You will the progress bar processing, once it has reached 100% you will
have been successful.

Home Reports Tools Configuration Help

¢ & @ [ ' ' ' o
3 B & vy 3 _, ¥ kB
:; @ I_I o G) - .E_:L = l M [l ]
Close Clients  Enrolments Enquiries To-do  Accredited Mon Accredited  Training Client Trainers Trainer Imvoices Qualification  Qualification AVETI
Exit and Results List Courses Courses Plans Companies  Assessors  Scheduler  Payments Rules Check File:
Trainer Scheduler
Course Filters Print/Export
Active Courses  + | Title match Course ID Version match #| Refresh & %) WA - m Manage PH

25 %

Now go back to Outlook and view the Calendar, you will see all your courses and in the set
colours if you created some rules.

17 |Page



